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As you and your team create content this area will fill 
up and display the latest updates.

Welcome to your new documentation space!

Use it to  , like your organisation's travel policies, design organize any information that people need to find and reference easily
guidelines, or marketing assets.

To start, you might want to:

Customise this overview using the   at the top right of this page.edit icon
Create a new page by clicking the in the space sidebar. + 

Tip: Add the     to any pages you want to appear in the   list below.label featured Featured pages

Search

NEED INSPIRATION?

Check out our guide on   to learn best practices for creating and organizing documents in Confluence.building better documentation

https://confluence.atlassian.com/confcloud/use-labels-to-organize-your-content-724764874.html
https://www.atlassian.com/software/confluence/documentation
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About Network Rendering
KeyShot Network Rendering allows you to connect multiple computer systems in your office network and utilize the available hardware to reduce 
rendering times significantly. In addition, rendering over the network is convenient. You may continue working in KeyShot or any other 
application without slowing down your system while the designated rendering stations process your render “jobs”.

The KeyShot Network Rendering software is compatible with macOS, Windows, and Linux. And like KeyShot, Network Rendering (9.1 and newer) 
can process jobs in both CPU and GPU mode, depending on the abilities of the connected Workers.

CPU Jobs

For CPU jobs, the correlation between render time and 
number of cores in your network is   approximately linear
and inversely proportional. In other words, by doubling 
the number of cores you potentially cut your render time 
in half.1

The more cores you have, the faster your images and animations will render.2

GPU Jobs

With GPU rendering the Render time can be even lower. E.g. Rendering on an NVIDIA RTX GPU will be 4-6 times faster than on an i7.1

You don't need a specific license to be able to render on the GPU. Each GPU will just take up 16 of the cores included in your License.

Visit the  page in the KeyShot Manual, for more information about requirements and limitations.GPU Mode

 Please note that this is an approximation under optimal conditions.  Render times are subject to hardware specs, core count, differences between workers, scene complexity, time scale, multi-tasking, and 1

network traffic.

Please note that Luxion does not sell or rent cores.  All computer hardware (i.e. processor cores) is provided by the customer.2 

https://luxion.atlassian.net/wiki/spaces/K9M/pages/1139015787/GPU+Mode
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How it works
KeyShot Network Rendering consists of three roles:  Clients, Manager, and Workers. 
The figure shown below illustrates the simplest interaction between the roles, where each computer only has one role.

A computer configured as a manager and/or worker can also function as a client. In the manager's case, KeyShot (the client application) 
communicates internally with the manager service which runs in the background.

It is important to note that there should only be one manager on the network! , if you need to have multiple managers on your network.Click here

The Manager can have both CPU and GPU workers connected, and will assign the tasks of a CPU/GPU render job to the type of workers that are 
relevant in each case. A worker can be set up to be available for CPU/GPU/both types of jobs if the hardware meets .requirements

Client Manager Worker
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Sends job requests to the manager (via 
KeyShot).
Receives completed jobs from manager.
Saves final output to specified location.
Can modify certain configurations of the 
manager, like users.

Receives job requests from clients and 
places them in a queue.
Divides each job into computation tasks.
Assigns tasks to each worker.
Compiles all rendered output into a final 
image, video, KeyShotXR or configuration.
Sends completed jobs back to clients.

Receives rendering tasks from 
manager that it computes.
Sends completed task results back to 
manager.

Performance Specifics

Bands and Regions

To understand what's happening when you send jobs to Network Rendering, it's important to know about bands and regions and the differences 
between the two. When rendering still images, KeyShot divides the Network Rendering jobs into smaller tasks and distributes those to individual 
workers using two different strategies; bands and regions.

Bands:  In general, bands divides into fewer tasks than regions. The default size of bands is 320 pixels in height x the entire width of the image. 
In CPU Mode, bands overlap by 10 pixels to smooth certain artifacts that would otherwise appear as discontinuities in the final image.
Regions: The default size of regions is 320 x 320 pixels. If you think about bands as overlapping rectangles and regions as squares, this might 
help you visualize what's going on.

Rendering Animation/KeyShotXR/Configurator does not by default use bands or regions. Instead, these renderings are divided and distributed to 
workers as individual frames.

The following tables show when KeyShot will divide Network Rendering jobs according to bands or regions.

CPU Mode Still Image Rendering

GPU Mode Still Image Rendering



Manual, KeyShot 9 Network Rendering

Note
You cannot directly dictate whether bands or regions are used when rendering. The selected lighting mode dictates whether bands or regions 
are used.
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Best Practices, CPU

Network Rendering Process

The manager receives a job from the Client. It splits the job into tasks that are computed by the workers. When a Worker finishes a task, the 
rendered pixels are returned to the Manager. When all tasks are completed, the Manager assembles them into the finished image, video, 
KeyShotXR, or configuration. For still images, the tasks consist of regions of the images, and for animations, KeyShotXRs, and configurations, the 
tasks are whole frames.

Total job processing time consists of transfer, rendering, and assembling time. The transfer time depends on network connection and file size, 
rendering time depends on Worker capacity and rendering settings (render passes and layers), and assembling time depends on the Manager 
capacity and output size (image resolution and number of frames).

Network Configuration of CPU Workers

The performance of KeyShot Network Rendering is subject to network connection and configuration. To obtain the best results we recommend:

To use the same processor type for all computers
To have an equal amount of cores per worker
The tasks assigned to each worker are generally of equal size, so if one worker is less powerful than the others it may delay the assembling of 
the job
To maximize the core count but minimize the worker count
This will decrease the time spent on transferring the scene to all workers. Also, if the number of workers exceeds the number of tasks of the job, 
the excess workers will be left idle if no other jobs are in the job queue
1 Gbit network interfaces or faster.

CPU Specification

The performance of KeyShot Network Rendering is dependent on your CPU specification. To obtain the best results, select high performance 
processors, e.g. Intel Xeon or AMD Threadripper. See our  section in the KeyShot forum for inspiration.Benchmark
Jobs suited for Network Rendering

As mentioned above, the total processing time of a job in network rendering is dependent on effective transfer, rendering, and assembling time. 
This is the reason why the following kinds of jobs are best suited for network rendering:

Complex scenes
KeyShotXRs
Configurations
Still images where local rendering times exceed 1 hour
Animations, KeyShotXRs, and Configurations where rendering time of each frame exceeds 10 minutes
If the rendering time pr. frame is less than that, the transfer time in Network Rendering could make local rendering more efficient.

Preparing jobs for Network Rendering

If you want the fastest processing time for your Network Rendering jobs, consider the following:

File Size - The file size affects the file transfer time. To minimize file transfer time, keep the BIP/KSP file size low. To minimize the size you can 
delete all unused items in the scene, such as unused environments, textures etc.
Rendering Settings - Everything you choose to include in the rendering counts. Render passes will increase the amount of data per pixel, and 
render layers will increase the amount of pixels being transferred.

On this page

Network Rendering Process
Network Configuration of CPU Workers

CPU Specification
Preparing jobs for Network Rendering
Linearity

https://www.keyshot.com/forum/index.php?board=36.0
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Linearity

In an ideal render farm, doubling the core count cuts the render time in half. To obtain maximum linearity between core count and render time:

Added CPU Workers must use the same processor (or better)
computers must have the same core count (or higher).
Current render times must be greater than 1 hour.
Number of render tasks must be greater than the current computer count.*

*Computer count should not be confused with core count. If the number of render tasks in a job is less than or equal to the current computer count, 
then adding more computers will not have any effect on the render speed for that job.
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Release Notes
The following page contains an overview of updates for KeyShot 9 Network Rendering.

9.2

Fixed issue where manager could get stuck if job contained a network path
Fixed issue where Windows clients could not download animations rendered with a Mac or Linux Manager
Added splitter to allow adjusting panels in worker schedule window
Now shows render time in seconds

9.1

Support for GPU Rendering.
Network Configurator now only shows import settings for the current role
Improved compatibility with older KeyShot versions
Limit to one Manager on Multi-user systems
Fixed issues with resolved Worker hostnames in Worker Schedule.
Fixed issue where ‘Pausing' jobs could not be unpaused.
Fixed an issue where the ‘Pause worker' text changed to ‘Resume worker’, even though it the pausing was cancelled.
Fixed the Monitor window size being reset when sending a new job.
Fixed an issue where jobs would get stuck in .Sending
Make sure that remaining time estimate is calculated correctly when pausing jobs.
Fixed issue where the Monitor crashed when sending job while logged in as a user without permissions.
Fixed Manager crash when rendering scene with Region Rendering enabled.
Fixed translation issue in parts of the Network Configurator.

9.0

Support for Parallel jobs
Network Configurator, UI Rework, including merging the wizard and the network configurator.
Rename Master/Slave to Manager/Worker
Add Category to Network rendering Logs
Handle "out of memory" errors on workers.
Deactivate/transfer node-locked license
Inherit valid license from earlier installation
Bump Port numbers to 4807 and 4808
General fixes and improvements, including:

Fixed bug where Manager would crash when repeatedly sending large masses of jobs to network rendering
Fixed bug where Scattering media with Color adjust node as density crashed Linux Workers
Fixed bug where wrong region was rendered, when interior mode and network rendering mode are enabled
Fixed bug where the worker did not use the selected resource location
Fixed bug where NR email reporting crashed the Manager
Pausing worker when the worker is already inactive no longer asks you if you would like to finish or abort the current task

Relases

9.2
9.1
9.0
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Known Issues
Keyboard layout in Network Configurator is wrong. (macOS)

Details and workaround

If you are using another keyboard setup than English, you may experience that the Network Configurator switches to another layout, and you 
can't switch it back to normal.  

Workaround: If you can't find special characters such as @ in the keyboard layout, write the text in a text editor and copy it into the network 
configurator.
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1.  
2.  
3.  
4.  
5.  

Getting Started

Get KeyShot Network Rendering

You can download the latest version of KeyShot Network Rendering .here

License

The Manager requires a valid Network Rendering license, but computers functioning as workers and/or clients do not. The License limits how many 
workers you can use for Network Rendering, by stating how may cores that simultaneously can be active. One GPU counts as 16 cores.

Clients that send jobs to Network Rendering will need a valid KeyShot license. Learn more about .setting up the License on the Manager

Install

Network Rendering must be installed on all the computers you want to use either as Manager, Workers, or Clients.

When you install Network Rendering on your computer you effectively install the following applications:  

KeyShot Network Configurator: Here you set up the roles of the current computer.
Manager service*: Handles all jobs and assigns tasks to the available worker.
Worker service*: Renders the tasks (regions or frames) assigned by the manager.
KeyShot Network Monitor: Displays the job and worker status, and facilitates sending jobs from KeyShot to KeyShot Network Rendering.
KeyShot Network Worker Tray: Enables users to visually control how many cores a local worker is allowed to use.

*Although the Worker and Manager services are installed on your computer, you still need to “turn them on” inside the KeyShot Network 
Configurator application. When enabled, the Worker and Manager services run in the background.

 KeyShot Network Configurator

When the Network rendering is successfully installed install the Network Configurator will be launched. This will guide you through the configuration 
of your machine as a  and/or as a or simply as a Client by selecting .Manager Worker - Monitor only

On this page

Get KeyShot Network Rendering

License
Install

KeyShot Network Configurator
KeyShot Network Monitor
KeyShot Network Worker Tray

In this section:

Install
Setup
Render Over The Network

https://www.keyshot.com/resources/downloads/


Manual, KeyShot 9 Network Rendering

You can always edit the setup at a later stage, just open the Network Configurator and make your edits.

The following pages in this section will describe the configuration of Manager, Workers and Clients.

 KeyShot Network Monitor

After configuring your services, KeyShot Network Monitor enables you to connect your client computers to the Manager. It gives you an overview of 
all jobs in a queue, and gives you access to all the  .Monitor features

Note
Please note that it is recommended to only have one computer in your network configured as the Manager, especially if using Manager Auto-
detection.
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 KeyShot Network Worker Tray

If your computer is configured as a worker you will see the KeyShot Network  widget on your Task bar om Windows or Menu bar on Worker tray
Mac (this can be disabled in the Configurator). Its function is to set the number of cores that the worker service utilizes for rendering jobs.
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1.  

2.  

Install

Download

KeyShot Network Rendering can be downloaded .here

Install on Windows 

When you have downloaded the installer, launch it and follow the prompts. During the install process you will meet following topics:

Folder location: By default Network Rendering will be located in Program Files and Network Resources in the Documents folder. You can change 
these if necessary.

Note that if Controlled folder access is enabled for the Resources folder (after installation), the PC won't be able to use Network Rendering. So you 
need to add the Manager/Worker services to the allowed apps in the Windows security settings.

Enable firewall access: if you have a firewall, you need to enable access for NR services in the firewall settings. Otherwise the communication to
/from Manager/Worker won't be possible. Auto-update, Multi-casting and Auto-detection will also be impacted by the firewall.

When You have completed the Installation the Network Configurator will be launched. This is where you can configure your computer as client
/worker/manager. Click  for more information.here

Install on macOS

When you have downloaded the installer, launch it and follow the prompts.

If you have a firewall you will need to enable the  in the installation type step. This will allow KeyShot Network Rendering to Setup Firewall Rules
pass the firewall which is necessary for the communication to/from Manager/Worker as well as Auto-update, Multi-casting and Auto-detection.

When You have completed the Installation the Network Configurator will be launched. This is where you can configure your computer as client
/worker/manager. Click  for more information.here

On this page

Download
Install on Windows
Install on macOS
Install on Linux

Also see

Silent Installation

Install on Linux

KeyShot Network Rendering has been verified on:

Ubuntu 16.04 and Ubuntu 18
Other distribution with glibc version 2.23 or later
Linux kernel version 2.6.32 or later

You can either install KeyShot Network Rendering via the Terminal or via the Linux UI. For setup via the Terminal follow the steps described in the 
readme file, which is included in the download package. Otherwise, follow these steps:

Download
Download the install package and save to a local drive, e.g. the  folder.Documents

Unpack
Launch the terminal and unzip the .zip file

https://www.keyshot.com/resources/downloads/
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2.  

3.  

4.  

luxion@ubuntu:~$ cd /home/luxion/Documents/
luxion@ubuntu:~/Documents$ unzip keyshot_network_rendering_linux64_9.2.
xx.zip 

Install
Run setup.sh

luxion@ubuntu:~$ cd /home/luxion/Documents/keyshot_network_9/
luxion@ubuntu:~/Documents/keyshot_network_9$ sudo -E ./setup.sh

Set up. Double click  and set up the services. See the following pages for step by step explanations of the settings.Run Configurator

Worker Setup
Manager Setup
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1.  

2.  

Silent Installation

You or your IT department may wish to do a KeyShot Network Rendering silent install, i.e., unattended installation. This is especially useful for 
unattended deployment onto servers. Please note that service setup is still required. To set up your manager or worker services, click .here

Windows

The following arguments are supported:

/S - Silent installation.
/D=<path> - Set the program files destination. This must be placed at the end of the command line inside quotations.
/config=<path> - Import settings from file.
/license=<path> - Install license from file. If a license exists it will be overwritten.
/resources=<path> - Sets resource path and copies existing license, config, and database, if present.
/manager - Enable manager service.
/worker - Enable manager service.
/mh=<host> - Sets manager host the worker will connect to (also enables worker service).
/mp=<port> - Sets manager port the worker will connect to.

Example of silent installation that will enable a worker and have it connect to "10.0.0.50" with default port:

keyshot_network_rendering_win64_9.x.x.exe /S /mh=10.0.0.50

Unattended uninstall:

C:\Program Files\KeyShot9 Network Rendering\uninstall.exe /S

macOS

Use the following approach to silently install KeyShot Network Rendering on macOS:

sudo installer -pkg keyshot_network_rendering_mac64_9.x.x.pkg -target /

In order to pass options to the installer, create the file "/tmp/ksnr9-silent-install.sh"

The file should fulfill the following conditions:

It must be owned by the user running the silent install

On this page

Windows
macOS
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2.  
3.  

It must not be writable by group
It must not be writable by other

The preferred file permissions are - .rw-r--r--

In the  file the following syntax is used : *.sh

export option=value

For example, to enable a worker service that  a manager at IP Address "10.0.0.50" include the following line in your  file:connects to *.sh

export LUX_NR_MANAGER_HOST=10.0.0.50

The following options are supported:

LUX_NR_RES_DIR=<dir> - Sets resource path and copies existing license, config, and database, if present.
LUX_NR_CONF_PATH=<path> - Import settings from file.
LUX_NR_LIC_PATH=<path> - Install license from file. If a license exists it will be overwritten.
LUX_NR_MANAGER=1 - Enable manager service.*
LUX_NR_WORKER=1 - Enable worker service.*
LUX_NR_MANAGER_HOST=<host> - Sets manager host the worker will connect to (also enables worker service).
LUX_NR_MANAGER_PORT=<port> - Sets manager port the worker will connect to.

*To disable Manager/Worker leave this option out (e.g. =0 will  disable the manager).LUX_NR_MANANGER not
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Setup
Once the Network Configurator is installed, it will launch automatically

and you can choose which role you want your computer to have in Network rendering.

When Network rendering is installed, your computer will be able to connect to a manager and display the queue in the Monitor. See the Network 
 page for more information.Monitor

General settings

Interface settings

You Start out by selecting the  and  color both of the Network Configurator and the MonitorLanguage Theme

Resources Location

KeyShot Network Rendering creates a Resources folder where it stores log information, system and temporary files. If necessary you can change 
the location of the resources folder, but it is not recommended to do so.

On this page

General settings

Interface settings
Resources Location
Role
Status
Role Specific settings

Also see:

Manager Setup
Worker Setup
Client setup
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Role

All computers with Network Rendering  KeyShot installed can send jobs to the manager on the local network. If the computer doesn't have and
KeyShot installed, it can still be a part of Network Rendering in one of the following roles:

Worker - Your computer will be rendering jobs delegated by the manager. Visit the  page for more information.Worker Setup
Manager - Your Computer will serve as the hub for the Network Rendering - It handles jobs sent from clients, splits them up in tasks which are 
delegated to the workers, and when the tasks are returned from the workers it assembles them to images, animations etc. Visit the Manager 

 page for more information.Setup
Worker and Manager - A computer can have multiple roles, as mentioned all computers with Network Rendering  KeyShot can send jobs to and
Network Rendering. But it can also serve both a Manager and Worker. Visit the  and  pages for more information.Worker Setup Manager Setup
Monitor only - If you only want to be able to administer the queue or to send Jobs to Network Rendering, all you need is the Monitor. Visit the Cl

 page for information on how to connect etc.ient setup

Status

The Status panel in the bottom of the window informs you about the current state of Network Rendering on your computer - what role it has and 
whether the service is running/needs to be restarted. It also lets you manually start/stop services in cans you don't want the service to automatically 
Restart services on Done.

Role Specific settings

The list in the left pane of the window leads the relevant settings for the selected role. The default values of those will in most cases be sufficient for 
running KeyShot Network Rendering, and if you are happy with those, just press Done and start Rendering.

If you have KeyShot you are now ready to .Render Over The Network
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Manager Setup

If you want your computer to serve as Manager on your network you select the Manager Role (or  if you also want it to Both Manager and Worker

contribute to the rendering force) in the Network Configurator 

Setting up the Manager

Launch the Network Configurator on the computer where you want to set up/edit the manager.

General Settings

Interface Settings

Select the  and  color both of the Network Configurator and the MonitorLanguage Theme

Resources Location

KeyShot Network Rendering creates a Resources folder where it stores log information, system and temporary files.

Default location of the Resources folder:

On this page

Setting up the Manager

General Settings

Interface Settings
Resources Location
Role
Status

Manager settings

License
Connection Settings
Job Settings

Users

Enable user system
Permissions

Update Checking
Email

Enable email notifications
SMTP Settings

Logging
Export/import

Also see

License
Get a TLS certificate
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On Windows: C:\Users\Public\Public Documents\KeyShot9NetworkResources
On Mac: /Library/Application Support/KeyShot9NetworkResources
On linux: /var/local/share/KeyShot9NetworkResources/

If necessary you can change the location of the resources folder, but it is not recommended to do so.

To change the location of the Resource folder click the lock icon to enable editing and browse to the chosen location.

Role

Select the  Role. Now the relevant settings for the Manager are available in list in the left of the window.Manager

If you are happy with using the default settings for the manager, you can actually skip the rest and finish the Network configurator here.

Status

The Status panel in the bottom of the window informs you about the current state on the manager, you can start it manually or set it to be restarted 
automatically when you finish the Network Configuration. If you are editing the settings of a manager that is already running, this will let you know 
when a restart is necessary

In the Network Configurator you can set up your computer as a Network Rendering Manager.

Manager settings

License 

You only need a license for the manager, this limits the number of worker cores that can be used at 
any given time, but it does not limit the number of users that can send jobs to Network Rendering.

There are 2 different types of licenses for Network Rendering

License File - the license file is located on the computer acting as manager.
Floating License - the license is handled by a license server which the manager connects to. 
This is the license type you need if you want to have   on your network.Multiple Managers

Visit the  page for a detailed walktrough on setting up the license.License

In the bottom of this section you can always see the current state of your license, as well as the cores 
limit and remaining days on the license.

Connection Settings

Auto detect workers and clients - When auto detect is enabled, workers and clients on the 
network will automatically connect to the manager. If not enabled you will need to enter the 
manager's IP and port information in their respective connection settings.
Monitor Client port - the default port for connecting monitors to the manager is 4087
Worker Port - the default port for connecting workers to the manager is 4087
RESTful API Server - When enabled you can get info about your Network Rendering setup, as 
json data.

Port - Set your custom port, the default is 8080
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TLS - Enable this if you want to encrypt/secure communications between manager and client 
systems. Visit the  page for more information.Get a TLS certificate

Job Settings

The Job Settings enables you to allow multiple jobs to be processed at the same time.

When set to 1, the manager will only start a second job if there is an excess of workers available for 
the current amount of tasks. This can result in situations where all workers are assigned to one large 

. With parallel jobs the Manager will job, and less heavy jobs are waiting while that job is in progress
be able to start multiple jobs - making everything flow more smoothly. The individual jobs may have 
longer render times, but the overall queue will be processed faster.

Users

Enable user system

The User System enables you to control who can see/access what in the Monitor.

Admin username/password - You need to set up an admin user for when  is User System
enabled on the manager. The Admin will be able to create  in the Monitor. By managing Users
users, the administrator controls who can  .submit, download, and/or delete jobs

Allow Anonymous Users - when enabled anyone with access to the Network can send jobs to 
rendering and view the monitor, even if they don't have a user. Visit the  page for more info.Users

Permissions

In addition to the User System you can set up limits to the content that is shown in the Monitor.
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Display image previews in the Monitor for all users - when enabled, everyone can see the 
image preview of a finished job. Otherwise it will only be visible to the owner of the job and users 
with permission to download jobs.

Update Checking

When  is enabled, the Monitor will check online for software updates every time it is Update Checking
launched, or when you log on to your computer. This setting is enabled by default.

Proxy: Select the type of proxy you want to use:

No proxy/Automatic proxy detection - you don't need to enter anything further.
HTTP/SOCKS v5 - Enter host and port. 8080 is the default port.

Enable proxy authentication - enable this if your setup requires authentication.

Username/password - Enter the username and password for the proxy authentication.
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Email

Enable email notifications

When email notifications are enabled Network rendering will notify the admin email in the selected 
situations.

Users who have entered their email in the account settings (in the monitor) will receive an email when 
a job is completed.

SMTP Settings

In order for the email notifications to work you need to connect a mail account for the outgoing mail

Host/Port - Fill in Host and Mail Client Port. You can find this information in your email client 
settings.
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1.  
2.  
3.  
4.  
5.  

TLS - You can enable TLS/SSL or leave it unchecked. If you do enable it, make sure to use 
ports 465 or 587.
Authentication - Enable and fill in your username and password for the outgoing mail.
Check settings - The Configurator will check your email settings and provide you with a 
confirmation message. 

Please consult your IT department for any troubleshooting when setting up SMTP.

Logging

The log files keep track of Network Rendering state, information, and potential errors. If you enable 
logging on your manager you can select which incidents you want logged and how long to keep the 
logs. The Logs will be stored in the Resources folder (as set in the general settings). And they can be 
viewed in the Monitor

. To enable logging, click on “logging” in the KeyShot Network Configurator and check the “Enable 
logging” option.

Log Level - Choose at what level to record logs from: (Choosing a higher log level will record all 
other log levels below it)

Trace - shows all types of log messages.
Information - no trace but shows warnings, errors, and fatals.
Warning - no trace and information, but shows warnings, errors, and fatals.
Critical - no trace, information, and warnings, but shows errors and fatals.
Fatal - no trace, information, warnings, and errors, but shows fatals.
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Days to keep logs - Set a cutoff time for saved logs. Any logs that pass the set time frame will be 
deleted.

Export/import

If you need to move your Network Rendering installation or simply want to reuse your current settings 
when upgrading, you can export User Accounts and/or Settings and import them on the new 
computer.

Export - Select what to export, press export and select a location for the exported zip file.

User Accounts: When enabled the export will include all user accounts on the manager. This 
includes username, privileges and email - no job history will be exported.
Settings: When enabled the export will include the network configurator settings as well as 
any worker schedules that have been created while connected to the manager.

Import - Press import and select the .zip file. Notice that the location of the Resources folder will 
not be applied from the imported settings. If you have enabled User System before importing, the 
local admin will remain as the "super administrator" of the Manager, the imported admin will be 
created as a regular user, with admin privileges (or, if they have the same username, it will be 
discarded). 
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Note that if you are importing settings and users from a Network rendering 7 or prior, all users will 
have to recreate their passwords.

Overwrite colliding local users - If there are already users on the manager you are importing 
to, you can select whether or not to overwrite the ones that have the same username. When 
enabled it will overwrite the current user with the settings and mail from the imported. When 
unchecked, it will skip the ones in the import file.

Note
The export will include the settings currently running on the manager. If you have made changes 
to the Network Configurator Settings you need to restart the configurator before exporting.
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License

You only need a license for the Manager. The License limits the number of worker cores that can be used at any given time, but it does not limit the 
number of users that can send jobs to Network Rendering.

There are 2 different types of licenses for Network Rendering

License File - the license file is located on the computer acting as Manager.
Floating License - the license is handled by a license server which the Manager connects to. With this license type it is also possible to have M

 on the same network.ultiple Managers

On this page

Using License File

Deactivating a license
Replacing The License File

Using Floating License

Replacing the Floating License
Multiple Managers

Using License File

1. Launch KeyShot Network Configurator on your manager.

2. Go to the Manager Settings.

3. Select  in the  section.License File License

4. If you have a license key, click  and fill out the form. Your network license should Register Key
activate automatically. Otherwise, click  save the text file and email it to Save license request, license

 for manual activation.@luxion.com

5. If you already have the license file, click  Browse to your license file and click   to Select file, Open
select it.

6.  Your license file installed. The license text shows you how many cores the workers (combined) 
can use for Network Rendering and when the license will expire. Note that 1 GPU will count as 16 
cores.

Deactivating a license

In some cases you may need to move your license to another computer. in such cases you can click 
, move the .lic file to the other computer and follow the steps above to set up the Deactivate license

license on the new manager.

Replacing The License File

If you have received a new license file from us, you may easily replace the old license and update 
your Manager service. Just follow the steps above. Notice that if a user has KeyShot Network Monitor 
is open, while replacing the license file, it will briefly lose connection to the manager (the manager 
needs to re-start).  When prompted, check your Monitor connection settings and click . The Apply
client-manager connection will come back up.

mailto:license@luxion.com
mailto:license@luxion.com
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Using Floating License

(Windows and Mac only)

If you don't already use Luxion License Server for your keyshot licenses you can follow this guide to 
install the Luxion License Server.

1. Launch KeyShot Network Configurator on your Manager.

2. Go to the .Manager Settings

3. Select   in the  sectionFloating License  License

https://luxion.atlassian.net/wiki/spaces/K9M/pages/1062437429/Luxion+License+Server+Installation
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4. Enter the hostname or IP Address of your license server. If the server uses another FlexLM port 
than the standard (27000) you need to specify the port number, followed by the “@” sign and the 
server’s hostname/IP (e.g. 27000@KeyShotServer.local). Click Connect.

5.  Your license had been installed. The license text shows you how many cores the workers 
(combined) can use for Network Rendering and when the license will expire. Note that 1 GPU will 
count as 16 cores.

Replacing the Floating License

If you have received a new floating license from us you need to replace it in the Luxion License 
 There is no need for updating it in the Network Rendering Configurator, as the License Server Server.

will handle everything.

Multiple Managers

With the floating license you have the option of having multiple managers on the network - learn more 
.here

https://luxion.atlassian.net/wiki/spaces/K9M/pages/1062437429/Luxion+License+Server+Installation
https://luxion.atlassian.net/wiki/spaces/K9M/pages/1062437429/Luxion+License+Server+Installation
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Get a TLS certificate

If you want to increase the protection of your creative assets, you may want to encrypt the Network rendering communication. This can be done via 
TLS, see how in the .Manager Setup

There are three ways to get a TLS certificate: buy one via a certificate authority, get a free one via , or create a self-signed certificate.Let's Encrypt

Buy certificate

There are many places to buy. Here are a few:

GoDaddy
DigiCert
RapidSSL

Free certificate via Let's Encrypt

Let's Encrypt is a certificate authority that creates free certificates that a just as secure as the ones you can buy.

The easiest way to get started is by following the instructions for their .Certbot

Create self-signed certificate

It is required to have  installed.OpenSSL

Open a terminal and write the following to create private key file "key.pem" and certificate file "cert.pem" (both in the  format):X.509

% openssl req -newkey rsa:4096 -nodes -x509 -keyout key.pem -out cert.pem
Generating a 4096 bit RSA private key
..............++
...................................++
writing new private key to 'key.pem'
-----
You are about to be asked to enter information that will be incorporated
into your certificate request.
What you are about to enter is what is called a Distinguished Name or a DN.
There are quite a few fields but you can leave some blank
For some fields there will be a default value,
If you enter '.', the field will be left blank.
-----
Country Name (2 letter code) []:.
State or Province Name (full name) []:.
Locality Name (eg, city) []:.

On this page

Buy certificate
Free certificate via Let's Encrypt
Create self-signed certificate

Trust Certificate

https://letsencrypt.org/getting-started/
https://dk.godaddy.com/offers/ssl-certificate/
https://www.digicert.com/
https://www.rapidsslonline.com
https://letsencrypt.org/getting-started/
https://certbot.eff.org/
https://www.openssl.org/
https://en.wikipedia.org/wiki/X.509
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Organization Name (eg, company) []:.
Organizational Unit Name (eg, section) []:.
Common Name (eg, fully qualified host name) []:127.0.0.1
Email Address []:.

Note that the value of the fields is not important except for the "Common Name", which must be the IP or domain name used by the Monitors to 
connect.

Put the real IP in place of "127.0.0.1".

Trust Certificate

If the following error, or similar, is given when trying to connect to the Manager, it's necessary to state that you trust the certificate:

Error: Connection error: The root CA certificate is not trusted for this purpose

On macOS, double-click the certificate file and add it to the "login" keychain. Click "My Certificates" in the left pane and find the item with the 
domain name or IP you input above. Double-click that item and set it to "Always Trust" for "Secure Sockets Layer (SSL)".

Note that the certificate must be downloaded to the computer first and imported into the local certificate key store (on macOS you just need to 
double-click it).
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Worker Setup

If you want your computer to serve as a worker on the network, you can enable this in the  KeyShot Network Configurator. When you enable 
worker mode, you will need to set the manager hostname and worker Port, Process Priority and the Allowed Cores.

Once you have the worker set up you can log into the Monitor and set the . If you are also using the computer for other things Worker Schedules
you can use the  widget to limit the number of cores or pause the worker temporarily.Worker Tray

Setting up the Worker

Launch the Network Configurator on the computer where you want to set up/edit the worker.

General Settings

Interface Settings - Select the  and  color both of the Network Configurator and the MonitorLanguage Theme

Resources Location - KeyShot Network Rendering creates a Resources folder where it stores log information, system and temporary files.

Default location of the Resources folder:

On Windows: C:\Users\Public\Public Documents\KeyShot9NetworkResources
On Mac: /Library/Application Support/KeyShot9NetworkResources

On this page

Setting up the Worker

General Settings
Worker Settings
Logging
Export/import

Also see

Worker Schedules
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If necessary you can change the location of the resources folder, but it is not recommended to do so.

Role - Select the Worker Role. Now the relevant settings for the Worker are available in list in the left of the window.

If you are happy with using the default settings for the worker, you can actually skip the rest and finish the Network configurator here.

Status - The Status panel in the bottom of the window informs you about the current state on the worker, you can start it manually or set it to be 
restarted automatically when you finish the Network Configuration. If you are editing the settings of a worker that is already running, this will let you 
know when a restart is necessary

Worker Settings

Connection Settings - Here you set up how the worker connects to the manager. With the default 
settings the worker will auto-connect to an manager on the same network.

Manager Hostname - Specify which manager the worker should connect to.
Worker Port - Set the port for the worker-manager connection. This should match the port set in 
the  - the default worker port in KeyShot 9 is 4808.configuration of the manager

Availabilty - If you are using the Computer for other purposes besides Network Rendering you may 
want to limit the availability.

CPU/GPU - Here you can select what type jobs the worker should be available for. The Worker 
can be one or both, . The GPU option will be disabled if the GPU does not meet requirements - 
see below.
Process Priority - This will set the priority of the worker service in the computer, this is relevant if 
you are also running other applications on the computer. In which case a low priority will let the 
other applications use what they need of the available CPU resources first.
Allowed Cores - If you have enabled use of the CPU for Network Rendering, you can set the 
default number of cores that are made available for Network Rendering. If you need to limit it 
temporarily, you can do it via the .Worker Tray
GPU Devices - If you have enabled use of the GPU for Network Rendering, and you have 
multiple GPUs you can select which are made available for Network Rendering. If you need to 
limit it temporarily, you can do it via the .Worker Tray

Auto Launch (*not available for Linux Workers) - By default, all computers serving as Network 
Rendering workers will have the  running. You can find it in the Task menu on Worker Tray
Windows and the menu bar on Mac. In cases where you do not want the users to be able to easily 
limit/pause the cores you can disabled this.

GPU Requirements
GPU raytracing in KeyShot 9 supports NVIDIA GPUs built on Maxwell microarchitecture and 
supports CUDA Compute Capability 5.0 or later found in the Quadro M6000 or GTX 980 
and above.

We recommend:
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5.  

Logging

The log files keep track of Network Rendering state, information, and potential errors. If you enable 
logging on your worker you can select which incidents you want logged and how long to keep the 
logs. The Logs will be stored in the Resources folder (as set in the general settings). And they can be 
viewed in the Monitor

. To enable logging, click on “logging” in the KeyShot Network Configurator and check the “Enable 
logging” option.

Log Level - Choose at what level to record logs from: (Choosing a higher log level will record all 
other log levels below it.)

Trace - shows all types of log messages.
Information - no trace but shows warnings, errors, and fatals.
Warning - no trace and information, but shows warnings, errors, and fatals.
Critical - no trace, information, and warnings, but shows errors and fatals.
Fatal - no trace, information, warnings, and errors, but shows fatals.

Days to keep logs - Set a cutoff time for saved logs. Any logs that pass the set time frame will be 
deleted.

Export/import

If you need to move your Network Rendering installation or simply want to reuse your current settings 
when upgrading, you can export User Accounts and/or Settings and import them on the new 
computer.

Export - The export will include the network configurator settings.
Import - Press import and select the .zip file. Notice that the location of the Resources folder will 
not be applied from the imported settings. And no user settings will er imported.

Graphics cards on the NVIDIA RTX  platform with a minimum of 8 GB memory.
Driver Version: For both KeyShot GPU on both Quadro and GeForce we recommend version 

.441.66

https://developer.nvidia.com/rtx
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Note
The export will include the settings currently running on the worker. If you have made changes to 
the Network Configurator Settings you need to restart the configurator before exporting.
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Worker Schedules

By default, a worker is active when connected to the manager. The worker schedules inside KeyShot Network Monitor offer control of when each 
worker will be active or inactive. Network administrators can setup the  by logging into his/her account from any manager, Worker Schedules
worker, or client computer. Learn more about .users

The Worker Schedules window shows a list of worker computers along with  .  The schedule is made up of each individual worker’s weekly schedule
red and green blocks. Green means active, while red means inactive. An active worker will use its processing power for rendering while an inactive 
worker will not use any of its processing power for rendering.

On this page:

How To Set A Worker’s Schedule

How To Set A Worker’s Schedule

1. Log In
Inside KeyShot Network Monitor, click  and enter your administrator credentials.File > Log in

2. Show Worker Status
If the Worker Status panel is not visible Click  to display it.Worker Status

3. Launch worker schedule manager
Inside the Worker Status panel, click .Worker Schedules
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4. Select Worker
Select the worker you want to set up a schedule for in the top list. Now you can either choose to use 
a preset schedule or create your own.

5. Worker Schedule Presets 
The worker schedule comes with two presets:

Always Active 
Non Work Hours - This will make the worker inactive Monday to Friday, between 8am and 5pm (8:
00-17:00).

6. Custom Schedules
You can also create your own schedule based on your rendering and processing needs. For 
example, you may want a worker to become active during lunch hour.  to Click the 1-hour blocks
toggle active/inactive.

7. Save your custom preset (optional)
Once you have set up your schedule, you can click  to save a custom preset.Save as preset

Name your preset and click .  You may now select this preset from the Presets drop-down (5).OK

8. Apply Schedule
Click . Your worker schedule is now set!Set Worker Schedule
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Client setup

Anyone on the network with KeyShot Network Rendering installed can connect to the Manager and view the queue via the Monitor. If you have the 
right user privileges, you can , reorder the jobs of the queue, and download and delete .administer users jobs

In order to submit jobs to Network Rendering you need to have KeyShot installed.

Installation

Download and install Network Rendering from . Upon installation the Network Configurator is automatically launched - Simply select here Only 
 and you are ready to go. The Monitor will automatically be launched when you finish the Network Configurator.Monitor

Establish Connection

In the Monitor under   you can specify the connection method.File > Connection Settings

By default, the connection is set to  and connect to the Manager. But you can also disable auto-detecting of the Manager and enter a Auto-Detect M
 and the correct  number, if you need to connect to a specific manager.anager hostname Monitor port

Also see

Log In/Out
Handling Jobs
Managing Set up Users
Clear the Monitor Queue

https://www.keyshot.com/resources/downloads/
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Render Over The Network
Once the   is complete and KeyShot Network Monitor is able to connect to the manager, you will be able to send your render jobs client configuration
to the network. In the instructions below we assume that KeyShot is installed on your client computer.

How to send a job to the network

1. Open your scene in KeyShot.

2. Open the Render dialog - It can be launched from the toolbar , via the  or the hotkey Ctrl+P (Windows) or Main menu > Render > Render
Cmd+P (Mac).

3. In the Options section select .Send to Network

4. Select  - You can submit jobs to Network Rendering in either CPU or GPU mode. If your computer is capable of rendering both Render Engine
the default choice will be Note that some materials/textures are not supported in GPU mode - .Inherit from Real-time View. learn more

5. Select the the rest of your render settings (visit the  for more details) and confirm by clicking the  button. If there  KeyShot Manual Send to Network
are no workers, using the same Render Engine, connected to the manager you will get a warning letting you know, so you can choose to switch 
mode or make sure appropriate Workers are made available to the Manager.

KeyShot will sync with KeyShot Network Monitor. Your job will be transferred to the manager computer and it will be added to the network queue. 
Anyone successfully connected to KeyShot Network Monitor will be able to see the list of jobs in the queue.

On this page

How to send a job to the network

https://luxion.atlassian.net/wiki/display/K72NR/Client+Configuration
https://luxion.atlassian.net/wiki/spaces/K9M/pages/1139015787/GPU+Mode
https://luxion.atlassian.net/wiki/spaces/K9M/pages/1062446197/Render+Options
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If you are unable to send jobs to the network, you can contact Luxion Customer Support at   for further assistance.support@luxion.com

Tip:
You do not need to be connected to the network while the job is being rendered. The images will be stored on the manager. Next time you 
connect to the manager, with the same user and computer, your finished jobs will automatically be downloaded to the given location. If you log 
into the monitor on another computer you can manually download your jobs. .Learn more

mailto:support@luxion.com
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User Interface
Network Rendering has 3 applications where you can interact with the service: KeyShot Network Monitor, KeyShot Network Configurator and the 
KeyShot Network Worker Tray. This section contains a brief user interface overview.

Network Rendering Configurator
Network Monitor
Worker Tray
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Network Rendering Configurator
 KeyShot Network Configurator allows you to configure your computer as a Manager, Worker, and/or Client.

Settings list

This overview shows you the settings relevant for the current role of the computer. Each setting is defined in the following pages:

Manager Setup
Worker Setup
Client setup

General Settings

Interface Settings

Language
Theme - defines the theme for the Netwoek Configurator, The Monitor and the Worker Tray

Resources Location

KeyShot Network Rendering creates a Resources folder where it stores log information, system and temporary files.

On this page:

Settings list
General Settings

Interface Settings
Resources Location
Role
Status
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Default location of the Resources folder:

On Windows: C:\Users\Public\Public Documents\KeyShot9NetworkResources
On Mac: /Library/Application Support/KeyShot9NetworkResources
On linux: /var/local/share/KeyShot9NetworkResources/

If necessary you can change the location of the resources folder, but it is not recommended to do so.

Role

Select the role you want the computer to have in the Network Rendering setup.

Status

The Status panel in the bottom of the window informs you about the current state on your computer, you can start services manually or set them to 
be restarted automatically when you finish the Network Configuration.

The Status panel is present on all steps of the Network Configurator. And will continuously inform you about errors and when changes to a service 
will require a restart.
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1.  

2.  

3.  

4.  

Network Monitor

 KeyShot Network Monitor allows you to interact with the network manager, workers, and view/administrate jobs in the queue.

When your computer is connected to a Manager you can find the Monitor icon in the Task menu (Windows) or the Menu bar (macOS)

Main Menu

In the Main menu you have following options:

File

Connection Settings - By default your computer will connect via auto-detect. But you can also specify the manager you want to connect to in 
the Connection settings.
Hide - if you don't want to see the monitor, you can hide it. You can always bring the Monitor back via the Monitor icon in the Task menu 
(Windows) or the Menu bar (macOS)
Quit - close the monitor. This will not quit the manager/worker services.

Edit

Download - Download job.
Move up/down - Reorder the queued jobs
Delete - Delete the selected job(s).

Help

About - Displays version information (this menu item is located in the  menu on mscOS).KeyShotNetworkRendering
License Information - will display license information from the manager you are connected to.
Manual - Links to this manual.
Check for updates - Check if there are updates for your Network rendering installation.
Auto-update - Keep the installation up to date.

On this page

Main Menu
Monitor window

Monitor window

Delete - Delete your render jobs. Administrators 
may delete any job. Visit the  page Set up Users
for more information about user privileges.

Worker Show/Hide  Status - Worker Status
panel (7).

Login account - Displays the logged in user’s 
name. Visit the  page for more Log In/Out
information.

Jobs filter - Select  or from the My Jobs All 
sidebar area. You may also filter either of these 
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4.  

5.  

6.  

7.  

8.  

9.  

by jobs that are In  or .Progress Completed

Render job queue - Lists all render jobs 
submitted to the network. Visit the   page for Jobs
more information about handling jobs.
For the best performance we recommend 
clearing the queue regularly. Learn more

Details about the selected job

Properties - Displays render job name, type 
of render, and owner. As well as a small 
thumbnail of what is rendering/rendered.
Preview - Displays image rendering progress.
Log - Lists all events related to the job.

Worker Status - Shows connected workers, 
available/allowed cores per worker, and the 
assigned regions. Possible status are shown 
below:

Ready – the worker is connected and is 
ready to render.
Updating – currently updating software; not 
available for rendering.
Receiving – currently receiving job data for 
the task to render.
Rendering – currently rendering.
Sending Results – sending results back to 
the manager.
Failed – if the worker fails 3 times it will be 
made inactive, waiting for an admin to take a 
look at the situation.

Worker Schedules - Show/Hide worker 
schedules toggle. Worker schedules determine 
when a worker is active or inactive. 
Visit the   page for more Worker Schedules
information.

Request all current logs - Download a ZIP file 
containing logs for all connected workers. You 
can also right click a worker to access the logs 
for that specific computer.  Visit the  Get Logs
page for more information.
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Worker Tray

When the worker service is running on your computer the    widget can be found in the Task menu on Windows or the Menu bar on Worker Tray
Mac.

The Worker Tray widget gives you the option of pausing or limiting the amount of cores used for Network Rendering. This is useful if you are 
making your work PC available as a worker, but still need to use it some of the time.

If your computer is available for Network Rendering with both CPU and GPU, it will be seen as 2 workers. This means that you can pause/limit the 
resources individually.

CPU Worker

Set Cores

The overall amount of cores that are made available for the manager is defined in the Network Rendering Configuration, but you can override that 
setting here and limit how many cores that are available.

Pause CPU Worker

Here you set the worker to paused, making it temporarily unavailable for the manager.

GPU Worker

Set enabled GPUs

If you have set up your Worker with multiple GPUs you can set a temporary limit to which GPUs are available for Network Rendering.

Pause GPU Worker

Here you set the worker to paused, making it temporarily unavailable for the manager.

Both

Use all cores on sign out

When this is checked all resources will be available for the manager while the user is signed out, but the machine is still running (not hibernated). 
The feature will default to the set number of cores when the user logs in again.

On this page

CPU Worker

Set Cores
Pause CPU Worker

GPU Worker

Set enabled GPUs
Pause GPU Worker

Both

Use all cores on sign out
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Connect to the Manager

Auto Detect Manager

By default Network Rendering is set up to Auto detect manager and workers/clients.

Worker and manager will just have to have the same port numbers specified in the Network Configurator and when you connect the Monitor you 
only need to keep the Auto-detect option checked, when you connect. You find the connection dialog in the Monitor menu File > Connection 
Settings...

On this page

Auto Detect Manager
Manually Connect to Manager
How To Change The Port Numbers
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Manually Connect to Manager

If Auto Detect is not enabled, or your network operates with Multiple Managers you can specify the Manager in the Connection Settings.

Disable  and fill in the manager hostname (or IP Address) as well as the port number.Auto detect manager

How To Change The Port Numbers

The Default port numbers are 

4807 to connect monitor and manager.
4808 to connect worker and manager.

We recommend keeping default port values. If you need to change the ports anyway you can do that in the Network Configurator. Make sure to 
change it on both  and .Manager Workers
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Log In/Out
You can log into your user account via the KeyShot Network Monitor from any manager, worker, or client computer. 

Logging into your network account allows you to download and/or delete your completed .jobs

If you need to be able to download/delete all jobs, , and  , these privileges can be added to your manage user privileges edit worker schedules
account by an administrator.

How To Log In

1. Launch KeyShot Network Monitor and go to ...File > Log in

2. Type your username and password. If you want to be logged in whenever the monitor is connected to a manager, be sure to check Log in 
.automatically when Monitor is started

On this page

How To Log In
Anonymous users
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3.  Click . Your name will appear at the top right corner inside the KeyShot Network Monitor window. Similarly, you will find  in the File Log In Log out
menu.

Anonymous users

Depending on the , anonymous users may be allowed to submit jobs for rendering.Manager Setup
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You are considered an anonymous user as long as you have not logged in. An anonymous user may only download jobs that he/she created as 
long as these jobs were sent from his/her current client computer.
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Set up Users
If  has been enabled on the manager (view the  to learn more), users can log into their accounts from any computer on User System Manager Setup
the network via the Network Rendering Monitor. Network administrators may access the user management system, add or remove accounts, and 
change privileges for each account.

In the instructions below, we assume that you have set up administrator credentials on your .manager

How To Add/Remove Accounts

1. Log In
Launch KeyShot Network Monitor, click  and log in with your administrator credentials. File > Log in

2. Open User Settings
In top right corner of the monitor you can now see that you are logged in. Click the triangle next to your username and select .User settings

On this page

How To Add/Remove Accounts
How To Change Account Privileges
User Privileges
Anonymous users
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3. Add or remove user
Click the Add (+) button to add or Remove (-) to remove a selected account.

Note: The main administrator, created in the Network Rendering Configurator, can not be removed.
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4. Set up new user

When adding an account, fill in the appropriate information, assign privileges, and click . Now the respective user can log in using hisCreate User
/her credentials.

How To Change Account Privileges
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1. Select the account and enable/disable privileges.

If the  are enabled and the email is filed, the user will get a notice when a job is completed.Get Email Notifications

2.  Click  and close the user system dialog when finished.Update User

User Privileges

Administrator - The user can do all of the things below, as well as add/remove users.
Create Jobs - The user can send jobs to Network Rendering.
Modify jobs by others - The user can change priority, pause, and delete jobs by others.
Download Jobs by others - The user can download all jobs.
Manage worker schedule - The user can set up/edit Worker Schedules

Anonymous users

If  has been enabled in the  section of the Network Configurator on the manager, you do not have to be Anonymous Users User System & Security
logged in to be able to send jobs to Network Rendering. In this case, the computer from where the job is submitted will be listed as the user.

"Anonymous jobs" can only be deleted/downloaded from the computer that submitted them, unless you are logged in with administrator privileges.

https://luxion.atlassian.net/wiki/pages/createpage.action?spaceKey=K9NR&title=User%20System%20%26%20Security&linkCreation=true&fromPageId=1059784614
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Jobs
The Queue in the Monitor shows you the waiting, in progress and finished jobs.

You can log into your user account on any computer that is connected to the manager via the Monitor. Logging into your network account allows 
you to download and/or delete your completed jobs. If you submitted the job, without being logged in, you have to access the Monitor on the same 
computer, to be able to download/pause etc. the jobs.  can be given additional privileges so they can download and/or delete all jobs, Users manage

, and  .user privileges edit the worker schedule

The filter on the left of the monitor will enable you to quickly find your jobs.

Job Order

Jobs will generally be processed in the order they were submitted. Users with the right privileges can change priority of jobs (see details below). 
The Order can also be impacted by the capability of the Workers and the load of jobs. A Worker can only process  jobs matching their Render 

 (CPU/GPU), so if there are few GPU Workers but many GPU jobs the CPU jobs may seem to be processed faster. In the Queue you  setupEngine
can see details of each job, including the  of a job.Render Engine

On this page

Job Order
Change priority on a job
Download a job
Delete a job
Pause a job



Manual, KeyShot 9 Network Rendering

Change priority on a job

To move a job up/down in the queue order, simply right-click the job and select  of Increase priority Decrease priority.

Note: If a change in priority moves a processing job down in the queue, the current tasks in process will be finished, but no new tasks will be 
started on that job, until tasks from jobs with a higher priority are done.

Download a job

You do not need to be connected to the network while the job is being rendered. The images will be stored on the manager. Next time you connect 
to the manager, with the same user and computer, your finished jobs will automatically be downloaded to the given location. If you log into the 
monitor on another computer you can manually download your jobs.

To download a job, simply right-click the job in the queue and select .Download

Note: If you have sent the job to the manager anonymously (without being logged into the monitor), you can only download it from the same 
computer as it was uploaded from. If you want to download it form another computer you will need to be logged in with the appropriate privileges.

Delete a job

To delete a job, or a selection of jobs, select the job(s) in the queue and click the delete button or right-click the job and select .Delete

Pause a job

You can also pause jobs that are processing. In this case the current tasks will be finished and the job won't be resumed until it is unpaused. You 
find the pause/unpause options when you right-click a job.
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1.  
2.  
3.  
4.  

Get Email Notifications
In order for Network Rendering to be able to send notification, you must  in the Network Configurator, Email Settings on Enable Email Notifications
the manager.

There you need to enter an Admin email and set up an email account for outgoing mail. Visit the  page for more information.Manager Setup

Administrator notifications

When Email Notifications are enabled, the administrator can select which notifications he/she wants e.g. when a license is about to expire or when 
there is an error in the system.

User notifications

Users of Network Rendering can also get notified when a job is finished/failed. This requires that the user is logged in, while submitting the job. And 
that they have added an email in their user settings.

Add email address to user settings

Log in to the Monitor File > Log In
Click arrow next to your username in the top right corner of the monitor and select User Settings
Select your user in the list
enter or edit the email address associated with your user

On this page

Administrator notifications
User notifications
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1.  
2.  
3.  

4.  
5.  

Clear the Monitor Queue
The Manager stores information about all completed jobs, which will be displayed in the Monitor queue.

We recommend that the queue is cleared regularly as a large amount of jobs in the queue may impact performance.

An administrator can clear the queue in 2 ways:

Via the Monitor - Select the jobs in the queue and press Delete (or right-click and select delete). This will remove the jobs completely from the 
manager.

Directly on the Manager computer - delete the jobs via the on the manager.

Access the computer acting as the Network Manager.
Launch and click  next to the Manager, in the  sectionKeyShot Network Configurator Stop Status
Open your file browser and browse to .KeyShot Network Resources > Manager

Default location on Windows: C:\Users\Public\Public Documents\KeyShot9NetworkResources
Default location on Mac: /Library/Application Support/KeyShot9NetworkResources

Delete all sub-folders in the Manager folder. These are all the jobs in the queue (done and in-progress).
Go back to the and restart the Manager or click  while  is enabled.KeyShot Network Configurator Done Restart services on Done
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Get Logs
If Logging is enabled for the worker/manager, you can access logs via the monitor. The log files keep track of Network Rendering state, 
information, and errors.

To enable logging, launch the KeyShot Network Configurator on the /  and enable it in the Logging settings. Here you can also worker manager
select which incidents to log and for how long the logs are stored.

Access logs

Logs can be accessed via the monitor. Click the  button or right-click the worker, you want logs from, and select Request all current logs Request 
.current log file

On this page

Access logs
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1.  
2.  

Limit Worker Availability
If your computer is available for the network as a worker, but is also used for other things you may want to limit the availability for Network 
rendering.

This can be done in 2 ways:

Limit the amount of CPU cores/GPU's available for the network rendering
Limit when the worker is available

Changing the number of cores

CPU

The worker service is by default set to use  of your processor cores. To lighten the load, you can release some cores on your worker. The core all
limit can be set in 2 ways:

Default limit: You can set up a default limit in the   in the Network Rendering ConfiguratorWorker Setup
Temporary limit: The   widget enables you to set a temporary limit or pause your worker entirely. Please note that the worker Worker Tray
service will revert to its default settings when you restart the computer.

GPU

The worker service is by default set to use  available GPUs. If you have Multiple GPUs you may want to reserve some power for other things. all
You can select which GPUs are available for Network Rendering in 2 ways:

Default limit: You can set up a default limit in the   in the Network Rendering ConfiguratorWorker Setup
Temporary limit: The   widget enables you to set a temporary limit or pause your worker entirely. Please note that the worker Worker Tray
service will revert to its default settings when you restart the computer.

Setting limitations in the Worker Tray

1. Log into your worker computer and find the   Worker Tray widget, it is located in the taskbar on Windows and in the menu bar on Mac.

2. Right-click the Worker Tray widget and select .Set Cores/Set enabled GPUs

On this page

Changing the number of cores

Setting limitations in the Worker Tray
Limiting the times when the worker is 
available

Pausing the Worker Service from 
within the Worker Tray
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3. Change the number of cores or which GPUs are available. The worker service will restart in the background. Once it restarts, the worker will 
reconnect to the network.

Limiting the times when the worker is available

If you need all the power of the computer, for something other than Network Rendering, during parts of the day you can limit when the worker is 
available for Network Rendering. 

Default limit: In the Monitor you can set up a Worker schedule where you can limit the hours where the worker is available. Visit the Worker 
 page for more info.Schedules

Temporary limit: In the Worker Tray you can pause the worker.

Pausing the Worker Service from within the Worker Tray

1. Log into your worker machine and find the Worker Tray widget, it is located in the taskbar on Windows and in the menu bar on Mac.

2. Click Pause Worker.

3. Select  when prompted.AbortTask

Note
Note that is is possible to configure the  in a way that does not allow Workers to access to the Worker Tray. If this is the case you Manager
cannot temporarily limit/pause the Worker's availability for Network Rendering.

Changing the Worker Schedule requires the right user privileges. If you don't see the Worker Schedule button in the Monitor, ask your 
administrator to grant you permission or to set up an appropriate schedule for your computer.
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Multiple Managers
Generally having one Manager on the network is the way to go. This Manager will have access to all cores allowed by the license, and all 
connections with workers and clients can be established by auto-detection.

But in some cases you may need to have multiple managers - maybe group A must not be able to see what group B is working on and vice versa.

Setting up multiple managers

License

If you have a floating  you can have multiple managers. These will be sharing the number of cores allowed by your license. Follow the same license
setup procedure as you would normally do (see ) and refer to the same license server on all managers.Manager Setup

Connection

The key difference from one manager setups is, that you can not use  in the connection settings. You must set a fixed host in the Auto-Detect
connection settings for both  and .workers clients

Limit access

If you want to limit who can send jobs to the different managers, you can enable the User system on each manager (see ). This way Manager Setup
only registered users can access the Network Rendering on that specific manager.

On this page

Setting up multiple managers

License
Connection
Limit access
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Update Your Software Version
Manager, Workers, and Clients should all run the same version of KeyShot Network Rendering.

After an update, the Manager will automatically update connected Workers, but each Client (Monitors) will need to be updated individually.

Update the Manager and Workers

If Update Checking is enabled, the update service in the monitor will let you know when a new version is available. But you can also check for 
updates via the .Main menu > Help > Check for Updates

1. Update the Manager - on the computer acting as Manager you can update KeyShot Network Rendering in one of the following ways:

Download and install the latest KeyShot Network Rendering update from  https://www.keyshot.com/resources/downloads/
Launch the  and Click  in the update dialog.Network Rendering Monitor Update

2. Launch   KeyShot Network Configurator on your Manager.

3. Press  . Your Manager will re-start and all existing workers services will be automatically updated.Close and restart services

Update Clients (Monitors)

Clients need to be connected to a Manager in order to receive information about updates. As soon as your Client is connected to a Manager, the 
Monitor will check if your client is running the same version as the Manager - if they are not, you will be asked to update and given an update link. 
As mentioned above you can also always download and install the latest version from .https://www.keyshot.com/resources/downloads/

For help updating your network, you can contact Luxion Support at support@luxion.com

On this page

Update the Manager and Workers
Update Clients (Monitors)

https://www.keyshot.com/resources/downloads/
https://www.keyshot.com/resources/downloads/
mailto:support@luxion.com
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